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While Deltek has attempted to verify that the information in this document is accurate and 
complete, some typographical or technical errors may exist. The recipient of this document is 
solely responsible for all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is 
subject to change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are 
reserved. No part of this document may be reproduced or transmitted in any form or by any 
means, electronic or mechanical, or translated into another language, without the prior written 
consent of Deltek, Inc. 

This edition published August 2014. 

© 2014 Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and 
proprietary information of Deltek, Inc. and its licensors. The Deltek software, and all related 
documentation, is provided for use only in accordance with the terms of the license agreement. 
Unauthorized reproduction or distribution of the program or any portion thereof could result in 
severe civil or criminal penalties. 

All trademarks are the property of their respective owners.  
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Overview 
This document provides instructions for installing the latest Deltek Time & Expense with 
Employee Self-Service 9.0.1 hot fix bundle.  

 

The hot fix version number listed in Deltek Software Manager, such as Hot Fix 003, is 
represented by an “x” (for example, Hot Fix xxx) throughout this document.   

During this installation, you will perform the following steps: 

 Ensure that your system meets the installation prerequisites. Refer to the sections titled 
“Installation Prerequisites” and “System Requirements” for additional information. 

 Make backups of the following: 

 Deltek Time & Expense 9.0.1 WebLogic® Server software 

 Deltek Time & Expense 9.0.1 Internet Information Server (IIS) software (if 
applicable) 

 Deltek Time & Expense 9.0.1 database 

 Install the Deltek Time & Expense with Employee Self-Service 9.0.1 Hot Fix Bundle xxx 
software. 

 Apply Hot Fix Bundle xxx to your Deltek Time & Expense with Employee Self-Service 
9.0.1 database. 

Installation Package Contents 
This package includes the following: 

 Deltek Time & Expense with Employee Self-Service 9.0.1 Hot Fix Bundle xxx install. 

 Deltek Time & Expense with Employee Self-Service Version 9.0.1 Hot Fix Bundle xxx 
Installation Guide document. 

Installation Prerequisites 
The following prerequisites must be met before applying Hot Fix xxx to Deltek Time & Expense 
with Employee Self-Service 9.0.1: 

 Deltek Time & Expense with Employee Self-Service 9.0.1 software and database must 
be installed and operational. 

 You must have Administrative access to the WebLogic Server that hosts your Time & 
Expense 9.0.1 software. 

 You must have Administrative access to your Time & Expense 9.0.1 database. 

Platforms Not Supported in Deltek Time & Expense with 
Employee Self-Service 9.0.1 
The Deltek Time & Expense with Employee Self-Service 9.0.1 system does not currently support 
Web servers other than Internet Information Server (for example, Apache). 
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Deltek Time & Expense with Employee Self-Service may support other platforms in a future 
release.  

Discussion of Appendices 
The Deltek Time & Expense with Employee Self-Service 9.0.1 Hot Fix xxx installation instructions 
contains an important appendix that is listed in the following table: 

Appendix Title Description 

A Documentation Instructions for accessing the 
Deltek Time & Expense with 
Employee Self-Service 
9.0.1Hot Fix xxx documents 

Naming Conventions 
This section discusses the naming conventions used throughout these installation instructions. 

Drive Letters 
The drive letters used in these installation instructions are listed in the following table: 

Drive Description 

C: This is the drive where the Deltek Time & Expense with Employee Self-Service 
9.0.1 system files are installed. 

Directory Names 
The directory names used in these installation instructions are listed in the following table: 

Directory Name Description 

ORACLE\MIDDLEWARE This is the name of the directory where the WebLogic and Deltek 
Time & Expense with Employee Self-Service 9.0.1 software is 
installed. 

DELTEKTE90 This is the name of the directory where the Deltek Time & Expense 
with Employee Self-Service 9.0.1 software is installed. 

Database Name 
The database name used in these installation instructions is listed in the following table: 

Database Name Description 

DELTEKTE The name of the Time & Expense 9.0.1 database. 
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Internet Information 
Software installs, install instructions, technical guides, and release notes are available for 
download from the Deltek Software Manager (DSM). This is also where you will download 
software corrections and enhancements (hot fixes). DSM will be the only place to download the 
hot fix files. Deltek Knowledge Base articles will still exist explaining the fixes, but will contain 
links to DSM for retrieving the actual files. 

Deltek Software Manager Requirements 
You must meet the following requirements in order to run DSM: 

 Can be run from any desktop (that is, does not have to be run on Deltek application 
servers) 

 Requires Windows XP or later 

 Requires Microsoft .NET Framework 3.5 SP1 (3.5.1) 

 The following Deltek Knowledge Base article has a link to download the framework 
and also has a few examples of what you may see if you do not have the framework 
installed: 

https://deltek.custhelp.com/app/answers/detail/a_id/52469  

 

Refer to the DeltekSoftwareManager.pdf to learn more about DSM and how it works. 

To Launch DSM 
Go to https://dsm.deltek.com. 

 

When downloading the Time & Expense with Employee Self-Service 9.0.1 software, if you are 
prompted to download Hot Fixes as well, please do so. 

Logon 
Use the same username/password as for Deltek Customer Care Connect. 

 

Deltek Knowledge Base articles will also exist on the Deltek Website (http://www.deltek.com). 

To view Knowledge Base articles: 

1. Go to http://www.deltek.com. 

2. Click Support Login in the upper right corner of the screen. 

3. When the Deltek Support Login screen displays, perform the following: 

 Username — Enter your Support user name. 

 Password — Enter your Support user’s password. 

4. Click Log In. 

https://deltek.custhelp.com/app/answers/detail/a_id/52469
https://dsm.deltek.com/
http://www.deltek.com/
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If you have forgotten your username or password, click Account Assistance. If you 
have forgotten your username, enter your email address and click Email My 
Username. If you have forgotten your password, enter your username and click Reset 
My Password. 

5. When the Deltek Support Home Screen displays, click the Knowledge Center tab, and 
perform the following: 

 Refine by Product — Select Time & Expense from the drop-down list. 

 Refine by Category/Version — Expand Service Pack / Hot Fix from the drop-down 
list, and select 9.0.1. 

 Search Type — Leave as Phrases or select how you want to search from the drop-
down list. 

 Search by Keyword — Enter the specific text you are looking for, or leave blank to 
return all records for this version. 

6. Click Search. 

7. When the search results display, perform the following: 

 Click the link for the desired correction (under the Summary column). 

 When the desired correction loads, click the links in the Answers section to 
download the files. 

System Requirements 
The supported Database hardware and software requirements are listed in the following table: 

Component Hardware Requirements Software Requirements 

SQL Server 
Database 
Server 

Hardware requirements vary among the 
different Relational Database 
Management System (RDBMS) 
platforms. Consult with Deltek’s 
Systems Solutions team or your 
RDBMS platform vendor to determine 
the hardware requirements for your 
database server. 

 Microsoft SQL Server 2012, 
Microsoft SQL Server 2008 
R2, 

Or 

Microsoft SQL Server 2008. 

Please note that Microsoft 
SQL Server 2005 is NO 
LONGER supported. 

 Database Compatibility 110 
(SQL Server 2012) 

Or 

Database Compatibility 100 
(SQL Server 2008 R2, SQL 
Server 2008). 
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Component Hardware Requirements Software Requirements 

Oracle 
Database 
Server 

Hardware requirements vary among the 
different Relational Database 
Management System (RDBMS) 
platforms. Consult with Deltek’s 
Systems Solutions team or your 
RDBMS platform vendor to determine 
the hardware requirements for your 
database server. 

 Oracle RDBMS 12c Release 
1 (12.1.0.1), 

(Please note that you must 
first apply Hot Fix bundle 
008 or later before 
upgrading your database 
platform to 12c), 

 Oracle RDBMS 11g Release 
2 (11.2.0.1), 

Or 

 Oracle RDBMS 10g Release 
2 (10.2.0.5). 

Configuring Time & Expense on Oracle 12c 
Time & Expense 9.0.1 supports both Oracle 12c database architectures - non-CDB's as well as 
Oracle Multitenant. 

Clients must first apply HF Bundle 8 or later before upgrading your RDBMS to Oracle 12c. 

Time & Expense 9.0.1 supports use of pluggable databases (PDB's) that form a part of a 
container database (CDB). When hosting a Time & Expense database as a PDB, it is important to 
allocate adequate shared resources and / or limit the number of PDB's in the CDB in order to 
achieve and maintain optimal application performance. The database setup and configuration 
with Oracle multitenant will vary depending on the database workload characteristics, database 
size, concurrent users etc. 
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Backing Up Time & Expense 9.0.1 Software 
This section provides instructions for backing up your Time & Expense 9.0.1 software. During the 
backup process, you will complete the following steps: 

1. Stop your Time & Expense 9.0.1 WebLogic Server 

2. Backup the Time & Expense 9.0.1 system 

3. Backup your Time & Expense 9.0.1 database 

 

For the Deltek Time & Expense with Employee Self-Service 9.0.1 system to function properly, 
your WebLogic application server and the database server that hosts your Deltek Time & 
Expense with Employee Self-Service 9.0.1 database must have their system clocks 
synchronized with each other. Failure to do this may result in login and other system problems. 

Step 1: Stopping Time & Expense 9.0.1 WebLogic Server 

Purpose 
This step provides instructions for stopping your Time & Expense 9.0.1 WebLogic Server from the 
WebLogic console. 

Where 
You must perform this step on your Time & Expense 9.0.1 WebLogic application server. 
Microsoft’s Java Virtual Machine (MSJVM) or Sun Microsystems’ Java™ Virtual Machine (JVM™) 
must also be installed on this machine. 

 

The WebLogic Console tool used in this step requires either Microsoft’s Java Virtual Machine or 
Sun Microsystems’ Java Virtual Machine to be installed. If neither of these virtual machines is 
installed, you must install Sun Microsystems’ Java Virtual Machine. Sun Microsystems’ Java 
Virtual Machine is available free for download at http://java.com.  

To stop your Time & Expense 9.0.1 WebLogic Server, complete the following steps: 

1. Open your Web browser, and enter the following case-sensitive URL: 

http://<IP Address or Computer Name>:<Port>/console 

Where: 

 <IPAddress or ComputerName> identifies your Time & Expense 9.0.1 WebLogic 
application server. 

 <Port> is the unique port number that your Time & Expense 9.0.1 WebLogic 
application server uses to listen for connections. You specified this port value during 
the Time & Expense 9.0.1 software installation. The default is 7009. 

For example, http://10.2.2.154:7009/console 

2. When the WebLogic Server Administration Console screen displays, complete the 
following steps: 

 Username — Enter system. 

 Password — Enter the password for the WebLogic Administrative user. The default 
is weblogic. 

http://java.com/


Backing Up Time & Expense 9.0.1 Software 

 

Hot Fix Installation Guide 7 

 

3. Click Log In. 

4. When the Oracle WebLogic Server Administration Console Home screen displays in your 
browser, select the DeltekTE link that displays under the Domain Structure section in the 
middle of the left pane. 

 

It can take several minutes for the hierarchical tree to appear in the left pane. If the 
hierarchical tree does not appear or a new blank browser opens, you must add 
http://<IPAddress or ComputerName> (that is, http://10.2.2.154) to your Internet 
Browser Trusted Sites and/or install Sun Microsystems’ latest JVM™. See the note on 
the previous page for instructions for more information. 

5. When the Settings for DeltekTE screen displays, click the Control tab, and perform the 
following: 

 DeltekTEServer (admin) — Select the check box that displays to the left. 

6. Click Shutdown, and select Force Shutdown Now. 

7. When the Domain Life Cycle Assistant screen displays, click either of the Yes buttons. 

 

It can take several minutes for your Time & Expense 9.0.1 WebLogic Server to process 
the shutdown request. 

The shutdown request has completed if either of the following conditions on your Time 
& Expense 9.0.1 WebLogic application server is true: 

 The Windows Command Prompt that was used to launch your Time & 
Expense 9.0.1 WebLogic Server has terminated. 

 The status of the Time & Expense 9.0.1 Windows service that was used to 
start your Time & Expense 9.0.1 WebLogic Server has changed from Started 
to blank. 

8. Close the Web browser screen. 

Step 2: Backing Up Time & Expense 9.0.1 System 

Purpose 
This step provides instructions for backing up your Time & Expense 9.0.1 system. 

Where 
You must perform this step on your Time & Expense 9.0.1 WebLogic application server and 
Web server. 

To backup your Time & Expense 9.0.1 system, complete the following step: 

1. Make full system backups of the following servers: 

 Time & Expense 9.0.1 WebLogic Application Server 

 Microsoft IIS Web Server that hosts your Time & Expense 9.0.1 software (if 
applicable) 
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Step 3: Backing Up Time & Expense 9.0.1 Database on SQL 
Server 

 

Skip this step if your run Deltek Time & Expense 9.0.1 on Oracle. 

Purpose  
This step provides instructions for performing a backup of your Time & Expense 9.0.1 database. 

Where  
This step must be performed from the Microsoft SQL Server database server that hosts your 
Time & Expense 9.0.1 database, or a Windows client workstation that can connect to your Time & 
Expense 9.0.1 database with the Microsoft SQL Server Enterprise Manager client software. 

To back up your Time & Expense 9.0.1 database, complete the following steps: 

1. Click Start » All Programs » Microsoft SQL Server 2008 » SQL Server Management 
Studio. 

2. Do the following: 

 Server Type — Select Database Engine. 

 Server Name — Select your SQL server. 

 If you choose SQL Authentication in Authentication on the Connect to Server 
dialog box, enter sa in Login. In Password, enter the password you established for 
this username during the Microsoft SQL Server installation process. 

 Click Connect. 

3. Expand the <your database server name> node. 

4. Click the + on the Databases folder. 

5. Right-click your Time & Expense database (DELTEKTE). 

6. Click Tasks » Back Up to display the Back Up Database screen. 

7. Click the General tab. 

8. Do the following: 

 Source 

 Database — Select your Time & Expense Database (DELTEKTE) 

 Backup type — Full 

 Backup Set 

 Name — Enter a name for this backup set (that is, DELTEKTE.BAK). 

 Description — Enter a description for this backup set (optional). 

 Backup set will expire — Leave the default of 0 days. 

 Destination — Select either the Backup to Tape or Backup to Disk option, and 
then specify a backup destination. If no backup destinations display, click Add to 
add an existing destination or to create a new one. 
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 Click Source in Select a Page on the right and do the following: 

 Overwrite Media — Select Append to media (to append the backup to an 
existing backup on the backup device) or Overwrite existing media (to 
overwrite an existing backup on the backup device). 

9. Click OK to begin the backup procedure. When the backup is completed, the following 
message displays: 

“The backup operation has been completed successfully.” 

10. Click OK. 

11. Close the SQL Server Management Studio screen. 

 

For additional information on backing up your Microsoft SQL Server database, consult the 
Microsoft SQL Server documentation. Deltek strongly recommends that you regularly test 
and verify your database backups before proceeding with the remainder of this 
installation. 

Step 4: Backing Up Time & Expense 9.0.1 Database on Oracle 

 

Skip this step if your run Deltek Time & Expense 9.0.1 on Microsoft SQL Server. 

Purpose 
This step provides instructions for performing a backup of your Time & Expense 9.0.1 database. 

Where 
You must perform this step from the Oracle database server that hosts your Time & Expense 
9.0.1 database, or a Windows client workstation that can connect to your Time & Expense 9.0.1 
database with the Oracle client software. 

To back up the Time & Expense 9.0.1 database, complete the following steps: 

1. Perform an export of your Time & Expense 9.0.1 database using Oracle’s export utility. 
The recommended syntax for exporting the Time & Expense 9.0.1 database is as follows: 

exp system/<SystemPassword>@<DatabaseInstance> file=<ExportName>.dmp 
log=<LogName>.log owner=TC_0000, TC_0xxx, TC_0xxx, <SchemaName>, 
<SchemaName>, <SchemaName> 

Where: 

 <SystemPassword> identifies the password for your Oracle SYSTEM user. 

 <DatabaseInstance> identifies the Oracle SID for the instance containing your Time 
& Expense 9.0.1 database. 

 <ExportName> identifies the name of the export file you will be creating. 

 <LogName> identifies the name of the log file you will be creating. 

 <SchemaName> identifies the schemas that your company is currently using (that is, 
TC_0003, TC_0004, TC_0005, and so on). 
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Deltek strongly recommends that you test your database backups before proceeding with the 
remainder of this installation. 
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Application Server Installation 

Installing Hot Fix Bundle xxx 

Purpose  
During this step, you will install the Deltek Time & Expense with Employee Self-Service 9.0.1 Hot 
Fix xxx software on your WebLogic application server. 

Where 
This step must be performed on your Deltek Time & Expense with Employee Self-Service 9.0.1 
WebLogic application server. 

To install Hot Fix Bundle xxx, complete the following steps: 
1. Run DeltekTimeAndExpense901HotFixBundlexxx.exe to launch the Deltek Time & 

Expense with Employee Self-Service 9.0.1 Hot Fix Bundle xxx installation program. 

 

Due to enhanced security in Windows Server 2008, it is advised to use the option to 
Run as Administrator when launching the installation executables even when the 
logged in user has local administrative rights. This option is accessed by right-clicking 
the installation executable file name in Windows Explorer, and selecting Run as 
Administrator to launch the program. 

2. When the Introduction screen displays, click Next. 
3. When the License Agreement screen displays, review the license agreement, select the I 

accept the terms of the License Agreement option, and click Next. 

 

It can take several minutes for the License Agreement screen to display. 

4. When the Select Installation Type screen displays, select Apply Hot Fix to Application 
Server, and click Next. 

5. When the Pre-Installation Summary screen displays, review the installation parameters 
you have selected. If you want to change any settings, click Previous to go back and 
make the necessary changes. If you are satisfied with these settings, click Install to 
begin the installation. 

6. When the process is complete, the Install Complete screen displays, click Done to exit 
the installation. 

7. Review the log file, 
C:\Oracle\Middleware\DeltekTE90\DeltekTimeandExpense901HotFixBundlexxx_Inst
allLog.log. Scroll down to the Summary section, and report any Warnings, 
NonFatalErrors, or FatalErrors to Deltek Technical Support. 

 



Internet Information Server (IIS) Installation 

 

Hot Fix Installation Guide 12 

 

Internet Information Server (IIS) Installation 

 

Skip this section if you are NOT using Deltek Time & Expense with Employee Self-Service 9.0.1 
with IIS. 

Installing Hot Fix Bundle xxx 

Purpose  
During this step, you will install the Deltek Time & Expense with Employee Self-Service 9.0.1 Hot 
Fix Bundle xxx software on your IIS web server. 

Where 
This step must be performed on your Deltek Time & Expense with Employee Self-Service 9.0.1 
IIS web server. 

To install Hot Fix Bundle xxx, complete the following steps: 

1. Run DeltekTimeAndExpense901HotFixBundlexxx.exe to launch the Deltek Time & 
Expense with Employee Self-Service 9.0.1 Hot Fix xxx installation program. 

 

Due to enhanced security in Windows Server 2008, it is advised to use the option to 
Run as Administrator when launching the installation executables even when the 
logged in user has local administrative rights. This option is accessed by right-clicking 
the installation executable file name in Windows Explorer, and selecting Run as 
Administrator to launch the program. 

2. When the Introduction screen displays, click Next. 

3. When the License Agreement screen displays, review the license agreement, select the I 
accept the terms of the License Agreement option, and click Next. 

 

It can take several minutes for the License Agreement screen to display. 

4. When the Select Installation Type screen displays, select IIS Service Pack, and click 
Next. 

5. When the Pre-Installation Summary screen displays, review the installation parameters 
you have selected. If you want to change any settings, click Previous to go back and 
make the necessary changes. If you are satisfied with these settings, click Install to 
begin the installation. 

6. When the process is complete, the Install Complete screen displays, click Done to exit 
the installation. 

7. Review the log file, C:\inetpub\wwwroot\DeltekTC\DeltekTimeandExpense9 
901HotFixBundlexxx_InstallLog.log. Scroll down to the Summary section, and report 
any Warnings, NonFatalErrors, or FatalErrors to Deltek Technical Support.  
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Database Update 
This section includes the following steps needed to apply Hot Fix xxx to your Deltek Time & 
Expense with Employee Self-Service 9.0.1 software: 

1. Start your Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic 
application server. 

2. Use the browser-based WebLogic console utility to apply Hot Fix xxx to your Time & 
Expense 9.0.1 database schemas. 

3. Restart your Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic 
application server. 

Step 1: Starting Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server 

Purpose 
This step provides instructions for starting your Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server. You must start the WebLogic Server on your application server 
to gain access to the Deltek Time & Expense with Employee Self-Service 9.0.1 system. 

Where 
This step must be performed on your Deltek Time & Expense with Employee Self-Service 9.0.1 
WebLogic application server. 

To start your WebLogic server, complete the following steps: 

1. In order for the Start Time & Expense with ESS 9.0.1 Server Windows Command Prompt 
to have scrolling capability, perform the following: 

a. Click Start » Programs » Deltek Time & Expense with ESS 9.0.1. 

b. Right-click Start Time & Expense with ESS 9.0.1 Server, and click Properties on 
the shortcut menu. 

c. When the Start Time & Expense with ESS 9.0.1 Server Properties screen displays, 
click the Layout tab and increase the Screen buffer size Height from 300 to 3000. 

d. Click OK to save the changes. 

 

Before starting Time & Expense with ESS 9.0.1, make sure that all of your ports are 
opened for Inbound and Outbound traffic through your firewall: 

Database Server Port 

 Listen — 1433 (the default for SQL Server) 

 Listen — 1521 (the default for Oracle) 

Application Server Port 

 Listen — 7009 (the default)  

2. Click Start » Programs » Deltek Time & Expense with ESS 9.0.1 » Start Time & 
Expense with ESS 9.0.1 Server. This will open a Windows Command Prompt and 
launch a command script that starts the WebLogic Server. When the Windows Command 
Prompt window opens, you will see a series of messages scrolling down the screen.  
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Due to enhanced security in Windows Server 2008, it is advised to use the option to 
Run as Administrator when launching this command even when the logged in user 
has local administrative rights. 

It will take several minutes for the WebLogic Server to start. 

3. If your WebLogic Server starts successfully, the following message displays near the 
bottom of the command line shell window: 

<The server started in RUNNING mode.> 

 

If your WebLogic Server encounters errors during the startup process, the <The server started 
in RUNNING mode.> message will not display and the command line shell (DOS window) may 
terminate. If you do not receive the <The server started in RUNNING mode.> message or the 
command line shell terminates, you must do the following tasks: 

 Make a copy of the 
C:\Oracle\Middleware\DeltekTE90\servers\DeltekTEServer\logs\DeltekTEServer.log 
file. 

 Contact Deltek Technical Support. 

Step 2: Applying Hot Fix xxx to Time & Expense 9.0.1 Database 
Schemas 

Purpose  
This step provides instructions for applying Hot Fix xxx to your Time & Expense 9.0.1 database 
schemas. 

Where  
This step must be performed from a workstation that has Web browser client access via TCP/IP 
to the Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic application server. 
Microsoft’s Java Virtual Machine (MSJVM) or Sun Microsystems’ Java™ Virtual Machine (JVM™) 
must also be installed on this workstation. 

 

The WebLogic Console tool used in this step requires either Microsoft’s Java Virtual Machine or 
Sun Microsystems’ Java Virtual Machine to be installed. If neither of these virtual machines is 
installed, you must install Sun Microsystems’ Java Virtual Machine. Sun Microsystems’ Java 
Virtual Machine is available free for download at http://java.com. 

To apply Hot Fix Bundle xxx, perform the following: 

1. Open your Web browser and enter the following, case-sensitive, URL: 

http://<IPAddress or ComputerName>:<Port>/console 

Where: 

 <IPAddress or ComputerName> identifies your Deltek Time & Expense with 
Employee Self-Service 9.0.1 WebLogic application server; and 

 <Port> is the unique port number that your WebLogic application server uses to 
listen for connections. You specified this port value during the Deltek Time & 
Expense with Employee Self-Service 9.0.1 software installation. The default is 7009 
(for example, http://10.2.2.154:7009/console). 

http://java.com/
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2. When the WebLogic Server Administration Console screen displays, perform the 
following: 

 Username — Enter system. 

 Password — Enter the password for the WebLogic Administrative user. The default 
was weblogic. 

 Click Login. 

3. When the WebLogic Server Administration Console Home screen displays in your 
browser, click the DeltekTE link that displays under the Domain Structure section in the 
middle of the left pane. 

 

It can take several minutes for the hierarchical tree to display in the left pane. If the 
hierarchical tree does not display or a new blank browser opens, you must add 
http://<IPAddress or ComputerName> (for example, http://10.2.2.154) to your Internet 
Browser Trusted Sites and/or install Sun Microsystems’ latest JVM.  

4. When the Settings for DeltekTE screen displays, click the Application Configuration 
tab. 

5. When the Deltek Application Configuration Home screen displays, under the Connected 
Domain List heading, in the fields that display below the Domain Name heading, click 
the MASTER link. 

6. When the Database Login screen displays, perform the following: 

 Database Login ID: Accept the default of sa (SQL Server) or system (Oracle). 

 Database Password: Enter the SQL Server sa user’s password or Oracle system 
user's password. 

 Click Ok. 

7. When the Domain MASTER screen displays, click the Apply Service Pack link. 

8. When the Apply Servicepack for MASTER screen displays, perform the following: 

 Current Version — Accept the default of 9.0.1.0. 

 Target Version — Accept the default of 9.0.1.0. 

 

For all 9.0.1 hot fixes, the Current Version and Target Version will both be 9.0.1.0.  
You must still run Apply Service Pack to apply the latest hot fix.  

 TC_0000’s password: Enter the password for the TC_0000 user. 

 Click Execute to begin the upgrade process. 
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It can take several minutes to perform the upgrade. Upon successful completion, you 
will receive the following message: 

Process Completed Successfully! 

If you receive an error code instead of the above message, please complete the 
following steps: 

SQL Server: 

 Execute the following SQL statement in SQL Query Analyzer, connected to 
your DELTEKTE database as the sa user: 

SELECT * FROM TC_0000.DB_SCRIPT_AUDIT 

 Contact Deltek Technical Support. 

Oracle: 

 Execute the following SQL statement in SQL *Plus, connected to your 
DELTEKTE database as the SYSTEM user: 

SQL> SELECT * FROM TC_0000.DB_SCRIPT_AUDIT 

 Contact Deltek Technical Support. 

9. When the “Process Completed Successfully!” message displays, click the Application 
Configuration Home link that displays near the bottom of the screen. 

10. When the Deltek Application Configuration Home screen displays, under the Connected 
Domain List heading, in the fields that display below the Domain Name heading, click 
the SAMPLE link. 

11. When the Domain SAMPLE screen displays, click the Apply Service Pack link. 

12. When the Apply Servicepack for SAMPLE screen displays, perform the following: 

 Current Version — Accept the default of 9.0.1.0. 

 Target Version — Accept the default of 9.0.1.0. 

 

For all 9.0.1 hot fixes, the Current Version and Target Version will both be 9.0.1.0.  
You must still run Apply Service Pack to apply the latest hot fix.  

 Click Execute to begin the upgrade process. 
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It can take several minutes to perform the upgrade. Upon successful completion, you 
will receive the following message: 

Process Completed Successfully! 

If you receive an error code instead of the above message, please complete the 
following steps: 

SQL Server: 

 Execute the following SQL statement in SQL Query Analyzer, connected to 
your DELTEKTE database as the sa user: 

SELECT * FROM TC_0xxx.DB_SCRIPT_AUDIT 

 Contact Deltek Technical Support. 

Oracle: 

 Execute the following SQL statement in SQL *Plus, connected to your 
DELTEKTE database as the SYSTEM user: 

SQL> SELECT * FROM TC_0xxx.DB_SCRIPT_AUDIT 

 Contact Deltek Technical Support. 

13. When the “Process Completed Successfully!” message displays, click the Application 
Configuration Home link that displays near the bottom of the screen. 

14. When the Deltek Application Configuration Home screen displays, under the Connected 
Domain List heading, in the fields that display below the Domain Name heading, click 
the <Your_Domain_Name> link for the TC_0xxx Schema. 

Where: 

 <Your_Domain_Name> identifies the company domain you assigned to the 
TC_0xxx database schema when you originally installed the Time & Expense 9.0.1 
software. 

15. When the Domain <Your_Domain_Name> screen displays, click the Apply Service 
Pack link. 

16. When the Apply Servicepack for <Your_Domain_Name> screen displays, perform the 
following: 

 Current Version — Accept the default of 9.0.1.0. 

 Target Version — Accept the default of 9.0.1.0. 

 

For all 9.0.1 hot fixes, the Current Version and Target Version will both be 9.0.1.0.  
You must still run Apply Service Pack to apply the latest hot fix.  

 Click Execute to begin the upgrade process. 
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It can take several minutes to perform the upgrade. Upon successful completion, you 
will receive the following message: 

Process Completed Successfully! 

If you receive an error code instead of the above message, please complete the 
following steps: 

SQL Server: 

 Execute the following SQL statement in SQL Query Analyzer, connected to 
your DELTEKTE database as the sa user: 

SELECT * FROM TC_0xxx.DB_SCRIPT_AUDIT 

 Contact Deltek Technical Support. 

Oracle: 

 Execute the following SQL statement in SQL *Plus, connected to your 
DELTEKTE database as the SYSTEM user: 

SQL> SELECT * FROM TC_0xxx.DB_SCRIPT_AUDIT 

 Contact Deltek Technical Support. 

17. When the “Process Completed Successfully!” message displays, click the Application 
Configuration Home link that displays near the bottom of the screen. 

18. When the Deltek Application Configuration Home screen displays, under the Connected 
Domain List heading, in the fields that display below the Domain Name heading, click 
the <Your_Additional_Domain_Name> link for the TC_0003, or higher, Schema. 

Where: 

 <Your_Additional_Domain_Name> identifies the company domain you assigned to 
the TC_0003, or higher, database schema when you originally installed the Time & 
Expense 9.0.1 software. 

 

You must repeat items #18 through #21 of this step for EACH of the remaining 
Company Domains (that is, schemas TC_0003, TC_0004, TC_0005, and so on) that 
you want reconnected/upgraded. 

If you do not have any additional company domains, you may proceed to item 
#22 of this step. 

19. When the Domain <Your_Additional_Domain_Name> screen displays, click the Apply 
Service Pack link. 

20. When the Apply Servicepack for <Your_Additional_Domain_Name> screen displays, 
perform the following: 

 Current Version — Accept the default of 9.0.1.0. 

 Target Version — Accept the default of 9.0.1.0. 

 

For all 9.0.1 hot fixes, the Current Version and Target Version will both be 9.0.1.0.  
You must still run Apply Service Pack to apply the latest hot fix.  

 Click Execute to begin the upgrade process. 
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It can take several minutes to perform the upgrade. Upon successful completion, you 
will receive the following message: 

Process Completed Successfully! 

If you receive an error code instead of the above message, please complete the 
following steps: 

SQL Server: 

 Execute the following SQL statement in SQL Query Analyzer, connected to 
your DELTEKTE database as the sa user: 

SELECT * FROM TC_0003.DB_SCRIPT_AUDIT 

 Contact Deltek Technical Support. 

Oracle: 

 Execute the following SQL statement in SQL *Plus, connected to your 
DELTEKTE database as the SYSTEM user: 

SQL> SELECT * FROM TC_0003.DB_SCRIPT_AUDIT 

 Contact Deltek Technical Support. 

21. When the “Process Completed Successfully!” message displays, click the Application 
Configuration Home link that displays at the bottom of the screen. 

 

You MUST repeat items #18 through #21 of this step for EACH of your remaining 
Company Domains (that is, schemas TC_0003, TC_0004, TC_0005, and so on) that 
you want reconnected/upgraded. 

22. If your Oracle database is running in XA mode, skip to step 26.  If you’re NOT running in 
XA mode proceed to step 23. 

23. When the Deltek Application Configuration Home screen displays, under the Domain 
Structure section in the middle of the left pane, expand Services, and click Data 
Sources. 

24. Under the Change Center section in the top if the left pane, click Lock & Edit. 
 One by one, click each JDBC DSN and Pool and then select the Transaction tab. 

 On the Transaction tab, select Logging Last Resource. 

 Click Save. 

 Under the Domain Structure section in the middle of the left pane, expand 
Services, and click Data Sources. 

 

Make sure to repeat above steps for every Data Source.  

25. Under the Change Center section in the top if the left pane, click Activate Changes. 

26. Under the Domain Structure section in the middle of the left pane, click DeltekTE. 

27. When the Settings for DeltekTE screen displays, click the Control tab, and perform the 
following: 

 DeltekTEServer (admin) — Select the check box that displays to the left. 

 Click Shutdown, and select Force Shutdown Now. 
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28. When the Domain Life Cycle Assistant screen displays, click either of the Yes buttons. 

29. Close the Web browser screen. 

 

It can take several minutes for your Deltek Time & Expense with Employee Self-Service 9.0.1 
WebLogic Server to process the shutdown request. The shutdown request has completed if the 
Windows command line shell that was used to launch your Deltek Time & Expense with 
Employee Self-Service 9.0.1 WebLogic Server has terminated. 

 

Deltek recommends that you establish a Database Maintenance Plan for your Microsoft SQL 
Server Deltek Time & Expense with Employee Self-Service 9.0.1 database. Your Database 
Maintenance Plan should include a regularly scheduled task that updates the database statistics 
used by the SQL Server query optimizer. Regular updating of the statistics will ensure that the 
query optimizer has up-to-date information about the distribution of data values in the Deltek 
Time & Expense with Employee Self-Service 9.0.1 database's tables. Please consult your 
Microsoft SQL Server documentation for additional information on creating a Database 
Maintenance Plan for your Deltek Time & Expense with Employee Self-Service 9.0.1 database. 

Step 3: Configuring and Starting Deltek Time & Expense with 
ESS 9.0.1 Service 

Purpose 
This step provides instructions for setting up and starting the Deltek Time & Expense with 
Employee Self-Service 9.0.1 WebLogic application server instance to run as a Windows service. 

Where 
This step must be performed on your Deltek Time & Expense 9.0.1 WebLogic application 
server. 

To configure and start the Deltek Time & Expense with Employee Self-Service 9.0.1 to run 
as a Windows service, complete the following steps: 

1. Click Start » Programs » Administrative Tools » Services. 

2. When the Services window displays, scroll down the Services list, right-click the Time & 
Expense with ESS 9.0.1 service, and click Properties on the shortcut menu. 

3. When the Time & Expense with ESS 9.0.1 Properties screen displays, click the 
Recovery tab, and perform the following: 

 First failure — Change the drop-down selection from Take No Action to Restart 
the Service. 

 Second failure — Accept the default of Take No Action. 

 Subsequent failures — Accept the default of Take No Action. 

 Reset fail count after — Change from 0 to 1 days. 

 Restart service after — Accept the default of 1 minutes. 

4. Click Apply. 

5. In the Time & Expense with ESS 9.0.1 Properties screen, click the General tab, and click 
the Start button to start the Time & Expense with ESS 9.0.1 service. 
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The service will indicate that it started immediately. Please note, however, that it will 
take several minutes for the Time & Expense with ESS 9.0.1 service to fully initialize. 

After starting the service, you must wait several minutes before attempting to connect 
to the software. 

If you encounter problems with the Time & Expense with ESS 9.0.1 service, check the 
C:\Oracle\Middleware\DeltekTE90\servers\DeltekTEServer\logs\DeltekTEServer.log file 
and report any errors to Deltek Technical Support. 

6. Click OK to close the Time & Expense with ESS 9.0.1 Properties screen. 

7. Close the Services window. 
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Upgrading RDBMS to Oracle 12c 
Time & Expense 9.0.1 supports Oracle 12c RDBMS.  Your database must be at Time & Expense 
9.0.1 and hot fix bundle 008 (DeltekTimeandExpense901HotFixBundle008.exe), or greater, must 
be applied. 

 

Skip this step if you are not running Time & Expense 9.0.1 on Oracle 12c. 

Step 1: Upgrading your Database to Oracle 12c 
Now that your database has been upgraded to Time & Expense 9.0.1 and hot fix bundle 008 or 
greater has been applied, you may upgrade your RDBMS to Oracle 12c. 

Step 2: Modifying Connection Pool Files 

Purpose 
This step provides instructions for modifying your Time & Expense 9.0.1 connection pool files to 
make your connection work for Oracle 12c. 

Where 
You must perform this step on your Time & Expense 9.0.1 WebLogic application server. 

To modify your connection pool files, complete the following steps: 

1. Update the below connection pool files for Oracle located at 
<TE_INSTALL_DIR>\config\jdbc: 

 

SID is no longer used for Oracle 12c, and in the Database URL, between PORT 
and SERVICE_NAME, a “/” is required instead of the “:”. 

Update the database URL, changing this <host>:<port>:<SID or SERVICE_NAME> 

to this <host>:<port>/<SERVICE_NAME>: 

a. TC_0000_POOL-jdbc.xml 
b. TC_0001_POOL-jdbc.xml 
c. TCDSI_POOL-jdbc.xml 
d. TC_xxxx_POOL-jdbc.xml (if exists) 
e. CP-TC_xxxx_POOL-xxxx-jdbc.xml (if exists) 
f. CP-CP_xxxx_POOL-xxxx-jdbc.xml (if exists) 

Repeat (d-f) above for all additional connections pools. 

Step 3: Stopping Time & Expense 9.0.1 WebLogic Server 

Purpose 
This step provides instructions for stopping your Time & Expense 9.0.1 WebLogic Server from the 
WebLogic console. 
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Where 
You must perform this step on your Time & Expense 9.0.1 WebLogic application server. 
Microsoft’s Java Virtual Machine (MSJVM) or Sun Microsystems’ Java™ Virtual Machine (JVM™) 
must also be installed on this machine. 

 

The WebLogic Console tool used in this step requires either Microsoft’s Java Virtual Machine or 
Sun Microsystems’ Java Virtual Machine to be installed. If neither of these virtual machines is 
installed, you must install Sun Microsystems’ Java Virtual Machine. Sun Microsystems’ Java 
Virtual Machine is available free for download at http://java.com.  

To stop your Time & Expense 9.0.1 WebLogic Server, complete the following steps: 

1. Open your Web browser, and enter the following case-sensitive URL: 

http://<IP Address or Computer Name>:<Port>/console 

Where: 

 <IPAddress or ComputerName> identifies your Time & Expense 9.0.1 WebLogic 
application server. 

 <Port> is the unique port number that your Time & Expense 9.0.1 WebLogic 
application server uses to listen for connections. You specified this port value during 
the Time & Expense 9.0.1 software installation. The default is 7009. 

For example, http://10.2.2.154:7009/console 

2. When the WebLogic Server Administration Console screen displays, complete the 
following steps: 

 Username — Enter system. 

 Password — Enter the password for the WebLogic Administrative user. The default 
is weblogic. 

3. Click Log In. 

4. When the Oracle WebLogic Server Administration Console Home screen displays in your 
browser, select the DeltekTE link that displays under the Domain Structure section in the 
middle of the left pane. 

 

It can take several minutes for the hierarchical tree to appear in the left pane. If the 
hierarchical tree does not appear or a new blank browser opens, you must add 
http://<IPAddress or ComputerName> (that is, http://10.2.2.154) to your Internet 
Browser Trusted Sites and/or install Sun Microsystems’ latest JVM™. See the note on 
the previous page for instructions for more information. 

5. When the Settings for DeltekTE screen displays, click the Control tab, and perform the 
following: 

 DeltekTEServer (admin) — Select the check box that displays to the left. 

6. Click Shutdown, and select Force Shutdown Now. 

7. When the Domain Life Cycle Assistant screen displays, click either of the Yes buttons. 

http://java.com/
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It can take several minutes for your Time & Expense 9.0.1 WebLogic Server to process 
the shutdown request. 

The shutdown request has completed if either of the following conditions on your Time 
& Expense 9.0.1 WebLogic application server is true: 

 The Windows Command Prompt that was used to launch your Time & 
Expense 9.0.1 WebLogic Server has terminated. 

 The status of the Time & Expense 9.0.1 Windows service that was used to 
start your Time & Expense 9.0.1 WebLogic Server has changed from Started 
to blank. 

8. Close the Web browser screen. 

Step 4: Starting Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server 

Purpose 
This step provides instructions for starting your Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server. You must start the WebLogic Server on your application server 
to gain access to the Deltek Time & Expense with Employee Self-Service 9.0.1 system. 

Where 
This step must be performed on your Deltek Time & Expense with Employee Self-Service 9.0.1 
WebLogic application server. 

To start your WebLogic server, complete the following steps: 

1. In order for the Start Time & Expense with ESS 9.0.1 Server Windows Command Prompt 
to have scrolling capability, perform the following: 

e. Click Start » Programs » Deltek Time & Expense with ESS 9.0.1. 

f. Right-click Start Time & Expense with ESS 9.0.1 Server, and click Properties on 
the shortcut menu. 

g. When the Start Time & Expense with ESS 9.0.1 Server Properties screen displays, 
click the Layout tab and increase the Screen buffer size Height from 300 to 3000. 

h. Click OK to save the changes. 

 

Before starting Time & Expense with ESS 9.0.1, make sure that all of your ports are 
opened for Inbound and Outbound traffic through your firewall: 

Database Server Port 

 Listen — 1433 (the default for SQL Server) 

 Listen — 1521 (the default for Oracle) 

Application Server Port 

 Listen — 7009 (the default)  

2. Click Start » Programs » Deltek Time & Expense with ESS 9.0.1 » Start Time & 
Expense with ESS 9.0.1 Server. This will open a Windows Command Prompt and 
launch a command script that starts the WebLogic Server. When the Windows Command 
Prompt window opens, you will see a series of messages scrolling down the screen.  
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Due to enhanced security in Windows Server 2008, it is advised to use the option to 
Run as Administrator when launching this command even when the logged in user 
has local administrative rights. 

It will take several minutes for the WebLogic Server to start. 

3. If your WebLogic Server starts successfully, the following message displays near the 
bottom of the command line shell window: 

<The server started in RUNNING mode.> 

 

If your WebLogic Server encounters errors during the startup process, the <The server started 
in RUNNING mode.> message will not display and the command line shell (DOS window) may 
terminate. If you do not receive the <The server started in RUNNING mode.> message or the 
command line shell terminates, you must do the following tasks: 

 Make a copy of the 
C:\Oracle\Middleware\DeltekTE90\servers\DeltekTEServer\logs\DeltekTEServer.log 
file. 

 Contact Deltek Technical Support. 
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Logging into Deltek Time & Expense with 
Employee Self-Service 9.0.1 
This section provides instructions for verifying your Deltek Time & Expense with Employee Self-
Service 9.0.1.0 Hot Fix xxx installation. To confirm that your system is functioning properly, you 
will log in to your Deltek Time & Expense with Employee Self-Service 9.0.1 company domain(s). 

Logging into your Deltek Time & Expense with Employee Self-
Service 9.0.1 Company Domain through WebLogic 

Purpose 
This step provides instructions for logging into your Deltek Time & Expense with Employee Self-
Service 9.0.1 company domain(s). 

Where 
You can perform this step from any supported browser client that has TCP/IP access to your 
Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic application server. 

To login to your Deltek Time & Expense with Employee Self-Service 9.0.1 company 
domain, complete the following steps: 

1. Open your Web browser and enter the following, case-sensitive, URL: 

http://<IPAddress or ComputerName>:<Port>/DeltekTC/welcome.msv 

Where: 

 <IPAddress or ComputerName> identifies your WebLogic application server. 

 <Port> is the unique port number that your WebLogic application server uses to 
listen for connections. You specified this port value during the Deltek Time & 
Expense with Employee Self-Service 9.0.1 software installation. The default is 7009. 

For example, http://10.2.2.154:7009/DeltekTC/welcome.msv 

2. When the Deltek Time & Expense with Employee Self-Service screen displays, perform 
the following: 

 Login ID — Enter your login ID. 

 

The Login ID is case-sensitive. 

 Password — Enter your login user's password. 

 

The password is case-sensitive. 

 Domain — Enter <Your_Domain_Name>. 

Where: 

http://10.2.2.54:7001/DeltekTC/welcome.msv
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 <Your_Domain_Name> identifies the company domain you assigned to the 
TC_0xxx, TC_0003, TC_0004, TC_0005, and so on, database schema when you 
originally installed the Time & Expense 9.0.1 software. 

 Language — Select your language from the drop-down box (for example, 
English/United States). 

3. Click Login. 

4. When the Welcome screen displays, you can begin using the Deltek Time & Expense 
with Employee Self-Service 9.0.1 system. 

Accessing Deltek Time & Expense 9.0.1 through IIS 

 

Skip this step if you are NOT using Deltek Time & Expense with Employee Self-Service 9.0.1 
with IIS. 

To access Deltek Time & Expense 9.0.1 through IIS, complete the following steps: 

1. You can now access the Deltek Time & Expense with Employee Self-Service 9.0.1 
software by entering the following, case-sensitive, URL in your browser: 

http://<IPAddress or ComputerName>/DeltekTC/welcome.msv 

Where: 

 <IPAddress or ComputerName> identifies your Microsoft Internet Information Web 
server that will forward requests to your Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic application server. 

For example, http://10.2.2.154/DeltekTC/welcome.msv 

 

http://10.2.2.54/DeltekTC/welcome.msv
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Appendix A: Documentation 
This appendix lists the Time & Expense 9.0.1 Hot Fix Bundle xxx documentation and provides a 
brief description of each.  

Release Notes 
 DeltekTimeAndExpense901CumulativeHotFixXXX.pdf — This document contains a 

summary of the enhancements software problems resolved. 
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